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Abstract

Experimental autoimmune encephalomyelitis (EAE) is a common immune-based

model of multiple sclerosis (MS). This disease can be induced in rodents by active

immunization with protein components of the myelin sheath and Complete Freund's

adjuvant (CFA) or by the transfer of myelin-specific T effector cells from rodents primed

with myelin protein/CFA into naïve rodents. The severity of EAE is typically scored on

a 5-point clinical scale that measures the degree of ascending paralysis, but this scale

is not optimal for assessing the extent of recovery from EAE. For example, clinical

scores remain high in some EAE models (e.g., myelin oligodendrocyte glycoprotein

[MOG] peptide-induced model of EAE) despite the resolution of inflammation. Thus,

it is important to complement clinical scoring with histological scoring of EAE, which

also provides a means to study the underlying mechanisms of cellular injury in the

central nervous system (CNS).

Here, a simple protocol is presented to prepare and stain spinal cord and brain sections

from mice and to score inflammation, demyelination, and axonal injury in the spinal

cord. The method for scoring leukocyte infiltration in the spinal cord can also be applied

to score brain inflammation in EAE. A protocol for measuring soluble neurofilament

light (sNF-L) in the serum of mice using a Small Molecule Assay (SIMOA) assay is also

described, which provides feedback on the extent of overall CNS injury in live mice.

Introduction

Experimental autoimmune encephalomyelitis (EAE) is the

most common murine model for the human demyelinating

disease, Multiple Sclerosis (MS)1 . Classic MS inflammatory

pathology, including the infiltration of IFN-γ (gamma)

and IL-17-producing T helper cells2 , the infiltration of

inflammatory monocytes3 , the formation of perivascular
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and sub-meningeal inflammatory demyelinating lesions4 ,

and the occurrence of axon injury4  in the central nervous

system (CNS), is also observed in EAE5,6 ,7 ,8 ,9 . The

similarity in immune mechanisms between EAE and MS

has made EAE a suitable pre-clinical model for testing

the efficacy and mechanisms of action of a number

of approved immune-based therapies for MS, including

natalizumab, fingolimod, dimethyl fumarate, and glatiramer

acetate (reviewed in1,5 ). Certain EAE regimens model other

aspects of progressive MS pathology beyond axonal injury,

including the development of sub-meningeal inflammation

in the brain, chronic demyelination, spinal cord atrophy,

synapse, and neuron loss6,10 ,11 ,12 . Thus, EAE has utility for

screening the efficacy of neuroprotective therapies for MS.

EAE is induced in rodents in a number of ways. Active

immunization is the most common induction method and

involves immunization of rodents with myelin antigens (either

whole proteins or peptides) emulsified in CFA supplemented

with heat-killed Mycobacterium tuberculosis13 . Depending on

the strain of mouse, pertussis toxin (PTX) is also administered

on day 0 and day 2 of immunization to increase the

penetrance of disease13 . EAE can also be induced by

adoptively transferring myelin-specific T cells obtained from

myelin/CFA-primed mice into healthy mice14  or can develop

spontaneously in mice that overexpress T cell receptors

specific for the major myelin antigens5 .

EAE disease severity and progression are commonly scored

using a discrete 5-point clinical scale: 1 – tail limpness,

2 – hindlimb or foot weakness, 3 – complete paralysis

in one or both hindlimbs, 4 – forelimb weakness, 5 –

moribund or dead13 . This clinical scoring system is sound

in documenting the progression of ascending paralysis that

occurs at disease onset but is less sensitive at capturing

the extent of recovery from CNS inflammatory attacks. For

example, both mice that ambulate with difficulty and mice

that ambulate easily but exhibit foot-grasping weakness

are assigned a score of 2 on the EAE scale. Scores can

remain high in the post-acute phase of EAE due to the

presence of permanent axon injury or loss, even despite

the resolution of the inflammatory response9 . There have

been a variety of attempts at developing more refined scoring

systems, behavioral tests, measures of hindlimb and grip

strength, and infrared monitoring systems to better capture

differences in clinical deficits in EAE9,16 ,17 ,18 ; however,

these more intricate scoring measures do not distinguish

the contribution of inflammation versus tissue injury to the

underlying neurological deficits. Thus, the gold standard

approach to score the severity of EAE is to conduct both

clinical and histological scoring.

Here, a protocol is described for how to dissect and embed

mouse spinal cord and brain specimens in paraffin in a

way that captures the stochastic process of lesion formation

that occurs in EAE. A protocol is also presented of how to

stain sections with Luxol fast blue (LFB), originally created

by Kluver and Barrera19 , which detects myelin in the CNS.

Sections are either stained with LFB alone (for demyelination

analysis) or are counter-stained with hematoxylin and eosin

(H&E) to help visualize and score inflammatory lesions.

Protocols are also provided to quantify the presence of total

leukocytes (CD45), the loss of myelin, and the number of

injured axons (SMI-32) in the spinal cord using commercially

available antibodies, immunohistochemical (IHC) techniques,

and publicly accessible software. The protocol used to

quantify leukocytes in the spinal cord can also be applied to

quantify leukocytes in the brain.
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Histological evaluation of axonal loss and injury in the brain

is comparatively more difficult than in the spinal cord since

brain white matter tracts do not run in parallel to one another.

The measurement of serum neurofilament light (sNF-L) has

emerged as a promising biomarker for neuronal injury in

MS20,21 . Recent studies have extended this technology

to EAE22,23 ,24 . Here, a method is presented to measure

serum neurofilament light (sNF-L) in living mice using a Small

Molecule Assay (SIMOA) assay. This method requires only a

small quantity of serum and can be done in live mice in just

half a day, providing rapid feedback on how a tested therapy

is affecting overall CNS injury. All of the methods described

here can be applied to mice of any sex or strain.

Protocol

All experiments conducted with mice were performed under

animal use protocols approved by the Unity Health Toronto

Animal Care Committee, following the guidelines set forth

by the Canadian Council on Animal Care. Ensure to wear

a lab coat, protective gloves, and eyewear throughout the

laboratory procedures.

1. Harvesting and fixing the brain and spinal cord

1. Euthanize the mouse according to institutional policies.

Lay the mouse prone on a dissecting table and

decapitate using surgical scissors (cutting downwards).

2. Using Adson forceps (in non-dominant hand), grasp the

skin on the top of the mouse’s head. Then make a 2.5 cm

incision in the skin on the top of the head using surgical

scissors.

3. Use fingers to push the skin on the head laterally to

visualize the underlying skull.

4. Stabilize the mouse’s head by grasping eye sockets with

standard Adson forceps.

5. Using fine scissors (dominant hand), make small snips in

the skull along the midline from the cervical spine to the

olfactory bulbs.
 

NOTE: Embed only a few millimeters of scissor tips below

the skull at a time to avoid damaging the underlying brain.

6. Use Adson forceps with teeth to reflect the skull laterally

to reveal the underlying brain.

7. Hold the head using the non-dominant hand. Holding

scissors closed (dominant hand), scoop the spinal cord

out from the cervical spine and gently nudge the brain out

from the skull, snipping the cranial nerves.

8. Place the brain in a conical tube containing 10 mL of 10%

neutral buffered formalin that is labeled with the animal’s

ID.

9. Incise the fur along the midline of the mouse’s torso from

the neck to the tail.

10. Use fingers to push the skin laterally to visualize the

spine.

11. Using surgical scissors, cut downwards through the spine

at the level where the femurs attach to the hip.

12. Use surgical scissors to cut the body wall on each side

of the spine from the hip to the neck. Trim away any

attached organs.

13. Place the spine containing the spinal cord in the same

tube of formalin that contains the brain. Allow the brain

and spinal column to fix for 5–7 days.
 

NOTE: The timing of fixation is important. Some

antibodies will not work if tissue is over-fixed. If tissue is

under-fixed it is difficult to extrude the spinal cord from

the spinal column in step 2.

https://www.jove.com
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2. Grossing and processing of the spinal cord
and brain

NOTE: The following steps take place in a fume hood. Before

starting, prepare 2 x 10 cm clean Petri dishes, an Erlenmeyer

flask fitted with a funnel lined with filter paper, two scalpels

(one for cutting bone and one for cutting CNS tissues), lens

paper, a pencil, embedding cassettes, and specimen jars pre-

filled with 10% formalin.

1. Using scissors, cut a small piece of lens paper (the same

width but twice the length of the cassette) and place it in

one Petri dish.

2. Label a plastic cassette with the specimen ID using a

pencil.

3. Pour the tube containing the fixed brain and spine into

the funnel. Transfer the spine and brain to the empty Petri

dish.
 

NOTE: The used formalin will filter through into the

Erlenmeyer flask and can be re-used at step 2.13.

4. Grossly divide the brain into six coronal pieces using

a scalpel. Make one cut caudal to the cerebellum, one

in the middle of the cerebellum, one just rostral to the

cerebellum, and two cuts in the remaining rostral brain,

creating 3 additional coronal slices of equal thickness.

5. Using forceps, transfer brain specimens onto one half of

the lens paper in the Petri dish.

6. Cut the spinal cord into three pieces using the scalpel:

the first cut is made at the bottom of the rib cage, and

the second cut is made just below the curvature in the

cervical spine.    

7. Using the same scalpel, trim the sacral spine piece at the

caudal end until the spinal cord can be visualized.

8. Pick up the thoracic spine (non-dominant hand). Hold

Adson forceps with teeth tightly closed (dominant hand)

and gently push the end of the forceps into the smaller

opening of the spinal column using a gentle twisting

motion. The cord should emerge from the other end.
 

NOTES: Any round-ended instrument that is the size of

the spinal cord will work for this purpose. If the spinal cord

does not pop out naturally, do not force it. Instead, use

fine scissors to clip the bones along the side of the spine

and reflect it open to reveal the spinal cord. Alternatively,

fix the spinal cord and brain for a few additional days

in formalin; however, the same fixation time should be

applied to all specimens to avoid introducing variability in

antibody staining.

9. Pick up the standard Adson Forceps (dominant hand).

Still holding the spinal cord piece with the less-dominant

hand, use forceps to gently pull the emerged cord out of

the column. Place the spinal cord piece in the Petri dish

containing the lens paper.

10. Repeat this process for the lumbar/sacral and cervical

column pieces.    

11. Divide the three spinal cord pieces (cervical, thoracic,

lumbar/sacral) into smaller cross-sectional pieces using

a scalpel. Cut at least 15 segments, each of which should

be less than 2 mm thick.
 

NOTE: Ensure that the segments are shorter than they

are wide, which will make the sections fall more easily in

cross-section during the embedding process in step 3.

12. Arrange the spinal cord pieces on the same half of the

lens paper containing brain pieces. Fold the lens paper

over to sandwich the tissue pieces and place this in the

labeled cassette.
 

https://www.jove.com
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NOTE: The lens paper prevents small pieces of tissue

from escaping the cassette during processing.

13. Transfer the cassette into a specimen jar containing

recycled or fresh formalin.  

14. Repeat steps 2.1–2.13 for remaining specimens.

15. After 5-7 days of fixation, transfer cassettes from

the specimen container into the first formalin bath

in the automatic tissue processor (see Table of

Materials). Run the tissue processor overnight according

to the program described in Supplementary Table

1. Specimens are held in warm paraffin wax until

embedding.

3. Embedding and cutting brain and spinal cord
sections

1. Transfer cassettes from the processor to the warm

holding chamber of the paraffin embedding station (see

Table of Materials).

2. Embed spinal cord and brain cross-sections from each

mouse in a single paraffin block as follows (Figure 1):

1. First, pour paraffin wax just to cover the bottom of the

mould. Using fine forceps, place brain coronal and

spinal cord cross-sectional pieces into the paraffin in

the bottom of the mould.

2. Transfer mould to cooling surface for several

seconds to fix brain and spinal cord pieces in place.

Move the mould back to the heated surface and fill

it to the top with hot paraffin.

3. Place cassette lid (that is labeled with specimen ID)

on top of the mould. Pour more paraffin on top of the

cassette lid. Transfer the mould to the cooling station

to allow wax to set (cool for 30–60 min).
 

NOTE: Embedding spinal cord sections requires

practice. To improve success, use shorter lengths of

spinal cord (<2 mm) as these are more likely to fall

in cross-section. Surgical eye loupes can be worn

to help distinguish if spinal cord pieces are in cross-

section.

4. Mount paraffin block on rotary microtome. Trim block

until tissues of interest appear in paraffin section.

5. Cut 5 µM ribbons of sections of each block and

transfer them into a 42 °C  water bath.

6. Collect sections on slides and place slides in a glass

slide rack.

7. Bake sections at 37 °C in a dry oven overnight. Cool

slides before proceeding to staining.

4. De-paraffinization and rehydration of sections
in preparation for staining

NOTE: Steps are performed in a fume hood. Before starting,

prepare baths of solvents. Prepare 5 L of 1x PBS (1 L ddH2O,

8 g NaCl, 0.2 g KCl, 1.44 g Na2HPO4, 0.24 g KH2PO4; pH =

7.4) with 0.05% Tween-20 (PBS-T) for all washing steps.

1. De-paraffinize by placing slides in two consecutive baths

of xylene or a non-xylene based solvent on a shaker for

5 min each with gentle agitation.

2. Rehydrate tissues by transferring slides through

successive baths of descending percentages of ethanol:

2 x 100% ethanol (5 min each), 2 x 95% ethanol (3 min

each), and 1 x 70% ethanol (3 min). Hold in 95% ethanol

for LFB staining, and rehydrate to 70% ethanol, and hold

in PBS-T for immunohistochemistry (IHC).

https://www.jove.com
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5. LFB for myelin with H&E

1. Prepare a solution of 0.1% LFB (0.2 g LFB, see Table

of Materials, 200 mL 95% ethanol, 0.5 mL glacial acetic

acid). Mix and filter into an Erlenmeyer flask.  Store in a

dark bottle until use.

2. Transfer sections from 95% ethanol into a glass slide

rack that is placed in a staining dish containing LFB.

Cover the dish and seal with with paraffin film to prevent

evaporation.

3. Incubate sections at 56 °C oven overnight (maximum 16

h).

4. The following morning, transfer slides into a ddH2O bath

and hold.

5. Meanwhile, prepare (1) fresh 0.05% lithium carbonate

solution (0.05 g lithium carbonate, 100 mL ddH2O); (2)

Eosin Y solution (add 2 g of eosin salt to 40 mL ddH20

and mix until dissolved and then mix with 160 mL of 95%

ethanol).

1. Prepare the following baths: 1 x lithium carbonate,

3 x 70% ethanol, 3 x 95% ethanol, 2 x 100%

ethanol, 3 x ddH20. Place baths in order of use (see

Supplementary Table 2).

6. Follow the steps as outlined in Supplementary Table 2.

7. After the slides are dry, visualize the demyelinating

lesions under the microscope.

6. LFB for myelin without H&E

1. Perform this staining procedure for the analysis of myelin.
 

NOTE: The procedure is identical to step 5 (see

Supplemetary Table 2), but has an abbreviated work-

flow. After step 4, continue procedure starting at step 10.

7. Antigen retrieval and peroxidase quenching for
immunohistochemical (IHC) stains

NOTE: Before starting, prepare 100 mL of hydrogen peroxide

in methanol (1 part 30% hydrogen peroxide solution in 9 parts

100% methanol, in a fume hood). Prepare 1 L of 10 mM citrate

buffer with Tween-20 (2.94 g of trisodium citrate, dissolved in

1 L of ddH20 in a beaker on stir plate, bring pH to 6.0, and add

500 µl of Tween-20). Prepare PBS-T (see step 4). All washes

are done in baths of PBS-T with gentle agitation (on a shaker)

unless otherwise indicated.

1. Quench endogenous peroxidase by placing slides in 3%

hydrogen peroxide in methanol for 15 min (in a fume

hood). Wash slides twice in PBS-T (2 min each).

2. Transfer slides to a metal slide holder and place in 1 L of

citrate buffer in a pressure cooker. Seal the lid and add

a rubber stopper on the top of the steam escape vent.

3. Cook on high in the microwave until the yellow tab on

the pressure cooker pops up, indicating that maximum

pressure has been reached. Cook for an additional 5 min

at maximum pressure, and then remove the pressure

cooker from the microwave using protective gloves.

4. Depressurize by removing the stopper.  Remove the lid

and let the slides cool in the citrate buffer for 20 min and

then proceed to desired staining method.
 

CAUTION: Stand back when releasing the steam as it

can cause a scalding injury.

8. CD45 immunohistochemistry

NOTE: This IHC method is used to visualize infiltrating

leukocytes. The avidin/biotin blocking steps are combined

with the blocking and primary antibody incubation steps.

https://www.jove.com
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1. Prepare blocking buffer (2% BSA, 2% rabbit serum in 1x

PBS).

2. Transfer slides to glass slide tray and wash twice with

PBS-T (2 min each). Prepare avidin/blocking solution (4

drops/mL of avidin in 2% BSA/2% rabbit serum in 1 x

PBS, see Table of Materials).

3. Dry off excess PBS-T around tissue using a laboratory

tissue paper. Using a hydrophobic pen, draw a circle

around the tissue and place slide in the humid chamber.

4. Apply avidin/blocking solution onto each section (400 µL/

slide).

5. Cover humid chamber and incubate for 30 min at

room temperature.  During this step, prepare anti-CD45

antibody (Supplementary Table 3) in blocking buffer

containing biotin (4 drops/mL biotin, 2% BSA/2% rabbit

serum in 1x PBS).

6. Tap off blocking solution from slide onto a lint-free

laboratory wipe. Dab around tissue using a laboratory

wipe to remove excess liquid.

7. Place the slide back into a humid chamber. Add 400 μL

of CD45 antibody solution (see Table of Materials) onto

the section. Incubate overnight at 4 °C in a covered humid

chamber.

8. The next day, drain off primary antibody and wash slides

3 x in PBS-T (5 min each).

9. Dry area around section using a lint-free laboratory and

then add 400 μL of secondary antibody (1:200 dilution

in blocking buffer) onto each section. Incubate at room

temperature for 1 h.

10. Meanwhile, prepare ABC reagent (see Table of

Materials) by adding 2 drops of reagent A to 5 mL of

1x PBS and mix. Add 2 drops of reagent B to the same

solution and mix (prepare ~30 min before use).

11. Wash the slides in 3 changes of 1x PBS-T (5 min each)

and place the slides in a humid chamber.

12. Add 400 μL ABC reagent to sections. Cover humid

chamber and incubate for 30 min at room temperature.

13. Wash the slides in 3 changes of 1x PBS-T (5 min

each). Meanwhile, prepare an appropriate amount of

DAB solution in a foil-covered 15 mL centrifuge tube

according to the manufacturer’s instructions (see Table

of Materials).

14. Take one slide and focus on a spinal cord section under

a microscope. Add 400 μL DAB to the slide and start lab

timer.

15. Visualize the section while it is developing and stop timer

when leukocytes are brown. Transfer the slide into a

ddH20 bath to stop the reaction. Hold in water for 5 min.

The same development time is used for the remaining

slides.
 

CAUTION:   DAB is a carcinogen. Dispose of DAB waste

and post-DAB ddH2O as hazardous waste.

16. Counterstain slides with Mayer’s Hematoxylin for ~4-10

min (see Supplementary Table 2). Rinse slides under

running tap water for 10 min.

17. Dehydrate in 95% ethanol (1 x 3 min), followed by

absolute 100% ethanol (2 x 3 min each).

18. Moving into a fume hood, transfer the slides into xylene

or a xylene-substitute solvent for 5 min. Coverslip with

mounting medium, and allow the slides to dry for 1-2 days

in the fume hood.
 

https://www.jove.com
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CAUTION:   If using xylene, use double gloves and

forceps to handle slides when cover-slipping, since it is

toxic and can dissolve gloves.

19. Clean the slides using xylene and scan using a slide

scanner at 20 x magnification.

9. SMI-32 IHC for axonal damage

NOTE: This protocol uses a mouse SMI-32 antibody, which

reacts against non-phosphorylated neurofilament heavy,

which can accumulate in injured axons25 . Since this antibody

has been raised in mouse and detects a mouse antigen,

it is recommended that a Mouse on Mouse (MOM) kit be

utilized. In this procedure, the avidin/biotin blocking step

is done as a separate step from the primary antibody

incubation. Before starting this protocol, de-paraffinize,

rehydrate, quench endogenous peroxidase activity, and

conduct antigen retrieval as described in step 4 and step 7.

1. Wash sections twice with 2 x PBS-T (2 min each).

Remove extra liquid around sections using a laboratory

tissue and draw a circle around tissues using a

hydrophobic pen.

2. Add 400 μL blocking buffer (2% (w/v) goat serum in 1x

PBS-T) with avidin (4 drops/mL) to the sections. Incubate

for 15 min at room temperature.

3. Dip the slides twice in 1x PBS-T. Add 400 μL of blocking

buffer with biotin (4 drops/mL) to the slide and incubate

for 15 min at room temperature.

4. Wash the slides in a 1 x PBS-T bath for 2 min. Meanwhile,

prepare MOM blocking reagent by adding 2 drops of

stock solution (see Table of Materials) to 2.5 mL of 1x

PBS.

5. Add 400 μL of MOM reagent onto the section. Incubate

for 1 h at room temperature.

6. Wash the slides twice in a 1x PBS-T bath for 2 min.

Meanwhile, prepare MOM diluent by adding 300 μL of

protein concentrate stock solution to 3.75 mL of 1x PBS.

7. Add 400 μL of MOM diluent and incubate for 5 min at

room temperature. Meanwhile dilute the SMI-32 antibody

(see Table of Materials) in the MOM diluent.

8. Tap off the diluent from slides and add 400 μL of SMI-32

antibody solution onto section. Cover the humid chamber

and incubate for 30 min at room temperature.

9. Wash slides twice in a 1x PBS-T bath for 2 min, each with

gentle agitation. Meanwhile, dilute MOM anti-mouse IgG

working reagent in the diluent  (10 μL of stock in 2.5 mL

of diluent).

10. Add 400 μL of anti-mouse IgG working reagent per slide.

Incubate for 10 min.

11. Wash slides twice in a 1x PBS-T bath for 2 min each.

Continue staining following the steps outlined in CD45

staining protocol (step 8.11 – 8.19).

10. LFB and H&E scoring for the presence of
demyelinating lesions

NOTE: The following is an analysis approach that can be

applied to gain rapid insights into the severity of inflammatory

demyelination. This analysis is conducted in sections of

the cord sampled at different levels (cervical, thoracic, and

lumbar, at least 3 sections per/level). Refer to the Allen Brain

Atlas for Mouse spinal cord26  to help identify the anatomical

level of the spinal cord. This analysis requires TIFF files.

If scanned images are in .czi format, follow instructions in

Supplementary Table 4 to convert czi files to TIFF files.

1. Open the TIFF image of the section to be analyzed by

dragging and dropping the file into the ImageJ. Observe

https://www.jove.com
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the spinal cord section in 4 quadrants: dorsal, left lateral,

right lateral, and anterior (Figure 2A,B).

2. Score for the presence of demyelinating lesions in each

quadrant as depicted in Figure 2.
 

NOTE: The presence of a lesion results in a score of 1 in

that quadrant, for a total of 4 possible points per section.

A score of 1 is assigned even if there are multiple lesions

within a quadrant.

3. Add up all points for each mouse and divide by the total

number of quadrants sampled to obtain the fraction of

quadrants with sub-meningeal lesions.

11. Calculating the area fraction of LFB-staining
in spinal cord white matter

NOTE: This analysis measures the percent area fraction of

spinal cord white matter that is stained with LFB.

1. Open an LFB-stained section saved as a TIFF file by

dragging/dropping the file into ImageJ.

2. Click on Image > Type > 8-bit to produce a grey scale

image. Click on Image > Adjust > Threshold. Adjust the

bottom slider in order that the red overlay captures all

of the dark regions (myelin) seen by eye (Figure 2C–E).

Click on Apply.

3. Click on Analyze > Tools > ROI Manager to open the

ROI Manager.

4. Select the polygon drawing tool on the ImageJ tool bar.

This drawing tool allows one to outline a region of spinal

cord with the computer mouse.

5. Outline the dorsal region of spinal cord and add the

polygon to the ROI Manager by clicking t on the

keyboard.

6. Outline the anterior-lateral region of the spinal cord white

matter and add the polygon to the ROI manager.
 

NOTE: When tracing, exclude large blood vessels, tears

in the tissue, artifacts, and areas adjacent to the dorsal

horn (Figure 2A,B arrow), which are normally less

myelinated. Be as accurate as possible when tracing

since including too much white background will skew the

results.

7. Click on Analyze > Set Measurements and select Area

Fraction.

8. Click on Measure in the ROI Manager. This will give the

fraction of the outlined area that is stained with LFB.

9. From the newly produced results box, copy the values

into Excel and close the image window. Calculate the

average % fraction area stained for the dorsal and ventro-

lateral regions. Average these to get a value for that

section.

10. Repeat steps 11.1–11.9 for cervical, thoracic, and lumbar

sections (N = 3/level/mouse).   

11. Calculate the average percent myelin fraction for all

sections for each mouse. Percent demyelination is

estimated by subtracting the % area staining from 100.

12. Analysis of the number of CD45+  cells and
SMI-32+  axon ovoids

1. Drag and drop a CD45 or SMI-32 stained TIFF image into

ImageJ. Click on Analyze > Set Scale > Global > Ok to

set the scale bar across all images. Note that this is done

only for the first image.

2. Select the polygon drawing tool and trace around the

grey matter using the computer mouse. Click on Analyze

> Measure and record the results in Excel as “Grey

Matter Area”.

https://www.jove.com
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3. With the drawn polygon still on the image, remove the

grey matter from the image by clicking on the Delete key

(keyboard). This action leaves only the white matter to

be analyzed.

4. Outline the entire spinal cord section using the polygon

drawing tool. Exclude any regions of tissue that are

missing or damaged.

5. Click on Analyze > Measure and record the results as

“Total Tissue Area” in the Excel file.

6. Click on Image > Colour > Colour Deconvolution.

From the vectors drop-down window select H DAB.

Three new windows will appear – keep the brown hued

window (DAB channel) and delete other image windows.

7. Click on Image > Adjust > Threshold. Adjust the bottom

slider to threshold the image so that the red overlay

captures the same amount of brown staining detected by

eye. Click on Apply.

8. Click on Process > Binary > Watershed. At this step

compare the original image and the binary image to

assure that they are in agreement.

9. Click on Analyze > Analyze Particles. Select Show

Overlay and modify the settings: Size = 5 - 150 μm2 ,

Circularity = 0.4 – 1. Click on OK.
 

NOTE: These settings allow for individual cells and small

groups of cells that were not split with the Watershed

function to be included as opposed to being excluded in

the analysis.

10. In the results window, record the last number in the left-

most column in Excel, which represents the total particle

count. Then, calculate the white matter area (total tissue

area – grey matter area in mm2 ). Express total particle

count per white matter area (count/mm2 ).

11. Repeat steps for each saved RGB image. Once all

spinal cord sections have been analyzed for one mouse,

average the particle count per mm2  tissue for that mouse.

    
 

NOTE: The workflow used to analyze spinal cord

leukocytes can also be applied to brain regions.

13. Measurement of sNF-L using a SIMOA assay

1. Collect 100–200 μL blood from live mice by saphenous

bleed using capillary microtainer tubes or via cardiac

puncture using a syringe and 25 G needle (terminal

procedure). For the latter, transfer blood into a 1.5 mL

microcentrifuge tube.

2. Allow the blood to clot at room temperature for 30–60

min.

3. Centrifuge samples at 2660 x g for 5 min at 4 °C

and pipette the upper fraction (serum) into a new

microcentrifuge tube. Store the serum at -80 °C until

ready to use.

4. Preparation: Allow calibrators and controls (NF-light

assay kit, see Table of Materials) to warm to room

temperature for 1 h prior to use.  Take the enzyme

substrate (RGP) out of the refrigerator and place in a 30

°C waterbath for at least 30 min, vortexing every 10 min.

5. Thaw the serum samples on ice. Once thawed, gently

vortex samples and centrifuge at 10000 x g for 5 min to

pellet any debris.

6. Load the plate: Vortex the calibrators and the controls.

Load the calibrators in duplicate, controls in duplicate,

and serum samples in duplicate onto the 96-well plate

provided with the kit. Serum samples are diluted in a 1:3

ratio with diluent provided in the kit.  Seal the plate.

https://www.jove.com
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7. Turn on the SIMOA machine (see Table of Materials)

in the order of computer, program, and then machine.

Allow the machine to initialize and run Start of Day

maintenance.

8. Vortex the magnetic beads for 30 s.

9. Load Reagents tab on the screen, double clicking the

rack position where the reagent bottle is to be placed,

and then scanning the barcode of the bottle.

10. Place magnetic beads in the shaking position on the rack

(positions 1–3).

11. Continue, loading the detector, the SBG reagent, and

RGP reagent into the machine.

12. Click setting on the software. Ensure sample mode is on

plate. In the setup run tab, name the experiment.

13. Assign wells on the plate for the calibrators as follows:

Click the well, then select the assay. Select calibrate

A then click on ascending. Highlight wells A1-8 then

click replicates (2) to assign the coordinates for the

calibrators to be run in duplicate. Run using the neat

protocol.
 

NOTE: Refer to the certificate of analysis (manufacturer

website) to get the concentrations of each calibrator for

each particular lot number. Once wells are assigned, it

is not possible to navigate away from this screen without

losing the work, until the plate is locked in place.

14. Assign the samples following the steps below:

1. From the bottom right of the screen, click button

to assign the samples. Highlight wells where the

samples are to be located.

2. Check off the assay to be run from the list, chose

the number of replicates, and specify the onboard

dilution of 4x.

3. With the wells still highlighted, enter a prefix for the

sample ID and the starting number and then click on

generate to produce sequential IDs for the samples.

Repeat steps for control samples.

15. Load plate into the plate holder (A1 to A12).

16. On the screen interface, click on done programming

samples and proceed to system resources tab. Check

that all reagent containers are full and the waste

containers are empty.

17. Click on Run.

18. When the run is complete, check the calibration curve

under “Data Reduction” tab by selecting the assay and

plate name.

19. Go to “Run History” and use the filters to find the most

recent run. Select run and then all results. Click on

export, and save the .csv file. Click on  report and then

select batch calibration report and select the recent

run. Preview the report and export it.

20. Run the end of day maintenance recommended by the

manufacturer. Turn off the program, the machine, and

then the computer.

Representative Results

Figure 3 shows representative IHC and histochemical

staining, with examples of both acute (left) and older

EAE lesions (right). Representative CD45 staining with

hematoxylin counterstaining is shown in Figure 3A,B.  Figure

3C–F show examples of LFB staining with (Figure 3C,D)

or without (Figure 3E,F) the H&E counterstain. Though

hematoxylin is not specific to immune cells, the nuclei of the

immune cells stain more darkly and can be distinguished from

CNS resident cells. Figure 3G,H show representative staining

https://www.jove.com
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of SMI-32+  axons, counterstained with hematoxylin. Notice

the increased appearance of this stain in older EAE lesions.

Damage of myelinated tracks is most prevalent in the

spinal cord in active murine EAE and this is the main

driver of paralysis in this disease7,9 . Thus, scoring for the

presence of inflammation and tissue damage in the spinal

cord is prioritized in histological analyses. EAE lesions occur

sporadically at different regions (anterior, lateral or dorsal)

(Figure 2A,B) and at different levels (sacral, lumbar, thoracic,

cervical) of the spinal cord. The described embedding

method ensures good sampling of lesions throughout the

cord. More sections are embedded than analyzed, since

some sections can become damaged in the processing

or sectioning process. To ensure representative sampling,

a minimum of 3 representative sections are analyzed at

cervical, thoracic, and lumbar levels of the spinal cord for

each mouse. The identity of each specimen is blinded in order

that the person conducting the analysis is not biased when

selecting representative sections for analysis.

To gain quick insights into differences in the histological

severity of EAE, one can score for the presence of sub-

meningeal demyelinating lesions in spinal cord quadrants

in selected sections (Figure 2A,B). This is a rapid method

that can be performed on scanned images or using a light

microscope. This analysis is sensitive enough to detect

differences in histological EAE severity between groups when

EAE is severe in one group and mild in another. For example,

in the experiment in Figure 4, EAE was induced in female wild

type (WT) and mice with a deletion in OGR1 (OGR1 KO) using

MOG p35-55/CFA plus PTX. Mice in the WT group developed

severe EAE with complete paralysis, whereas the OGR1

knockout group developed mild disease. This difference in

clinical score corresponded to a difference in the fraction of

quadrants that had sub-meningeal lesions (Figure 4C).

It is important to complement the scoring of demyelinating

lesions with percent area fraction of myelin staining to capture

the extent of loss of myelin and/or myelinated axons during

the autoimmune attack. In the example in Figure 4, the

percent myelin fraction also differed signficiantly between the

OGR1 and WT mice (Figure 4D). The percent myelin fraction

also significantly correlates with the cumulative EAE score

in mice with EAE (Figure 4E) and therefore serves as a

good measure of overall tissue damage in this disease. Note

that this protocol does not distinguish the intensity of myelin

stain. If this is the desired outcome, one should conduct

immunofluorescence staining for myelin proteins such as

proteolipid protein or myelin basic protein and measure the

intensity of this staining.

In the case where EAE is severe in both comparator

groups, a higher fraction of spinal cord quadrants will contain

inflammatory/demyelinating lesions. In this case, a more

sensitive approach to score inflammation is to count the

number of CD45+  leukocytes per mm2  white matter (see

representative staining in Figure 3A). The CD45 antibody

clone described here detects all infiltrating leukocytes,

and only stains occasional microglia that upregulate CD45

expression in EAE (see open arrow in Figure 3B) and

therefore is useful at capturing peripheral immune cell

infiltration.

In longer-term EAE studies (>20 days), it is recommended

that one also carry out an analysis of axon injury. SMI-32

staining in spinal cord sections is a sensitive method to

detect damaged axons. Though inflammation in the spinal

cord subsides with time and spared axons can re-myelinate,

surviving axons exhibit a differential extent of residual

https://www.jove.com
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injury9  (Figure 3G,H). For example, in the MOG p35-55-

induced model of EAE in C57BL6/J mice, the extent of

axonal injury and loss is a driver of clinical scores after

the inflammatory process has subsided9 . Figure 5 shows

an example of this in an EAE experiment in male and

female mice WT mice and mice that are deficient in a

gene called peroxisome proliferator-activated receptor-delta

(PPAR-delta) in the myeloid compartment (LysMCre : Ppardfl/

fl). In the males, the WT mice regained hindlimb function, yet

the clinical scores remained high in male LysMCre : Ppardfl/

fl group. By contrast, in the experiment in the females, both

experimental groups had high scores throughout. At first

glance, this result suggested that PPAR-delta had a sex-

specific effect in EAE; however, pathological scoring of the

spinal cord revealed that mice of both sexes in the LysMCre :

Ppardfl/fl group had increased axonal injury compared to WT

counterparts (Figure 5B). A genotype effect on clinical scores

was likely not observed in females because WT female mice

tended to exhibit increased axonal injury, which manifested

into chronic neurological deficits.

In this same experiment, female LysMCre : Ppardfl/fl female

mice were found to have more extensive T cell infiltration in

the cerebellum, providing an example of how scoring brain

inflammation may be useful in EAE. In EAE, inflammation

in the brain is predominantly found in the cerebellum and

brain stem (Figure 6A,D,G), but can also be found in the

meninges (seen under hippocampus in Figure 6C), near the

ventricles (Figure 6F), and other white matter tracts including

the optic nerve and corpus collosum (Figure 6B,E). Scoring

brain inflammation is done in a specific brain region (e.g.,

cerebellar white matter) by counting the number of CD45

cells per mm2  tissue region using the same methodology as

outlined for the spinal cord protocol. In the grossing method

outlined here, a cut is in the middle of the cerebellum, which

provides the perspective of the cerebellum and brain stem as

shown in Figure 6A.

Measuring sNF-L using a SIMOA assay has become a useful

biomarker for assessing ongoing axonal injury and responses

to therapy in relapsing-remitting MS20,21 ,27 ,28 . The same

SIMOA assay kit used to measure of sNF-L humans can be

applied to measure mouse sNFL22,23 ,24 . To explore how

well this assay performs is detecting axonal injury in EAE,

sNF-L was measured in female C57BL6/J mice at the end-

point of an EAE experiment and levels were compared to

those in sex-matched healthy control mice that did not have

EAE. It was found that mice with EAE had much higher levels

of sNF-L than in healthy mice (Figure 7A) and these levels

correlated with the density of SMI-32+  axons in the spinal

cord  (Figure 7B). Compared to histological scoring of axonal

injury, the SIMOA assay is faster (from bleeding mice to

results can be achieved in just over half a day) and therefore

provides rapid feedback of how a treatment is working in living

mice. This assay also has the advantage that it reflects axonal

injury in both the spinal cord and the brain.

https://www.jove.com
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Figure 1: Representative paraffin block of brain and spinal cord sections. The 5 coronal brain sections and spinal cord

cross sections (1.5–2 mm thick) are embedded in the same block in order that they can be cut in one section. At least 15

sections of spinal cord should be embedded, allowing for adequate selection of sections for analysis. Please click here to

view a larger version of this figure.
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Figure 2: Scoring meningeal inflammation and percent myelin area at the level of the thoracic spinal cord. (A,B)

show images of the thoracic spinal cord from a female C57BL6/J mouse with MOG p35-55-induced EAE stained with LFB/

H&E. Shown is the approach used to visualize quadrants and examples of demyelinating lesions (traced in dotted line). The

mouse in A has 4 of 4 quadrants with confluent demyelinating lesions, while the mouse in B has 1 of 4 quadrants affected.

The mouse in B does have some inflammation in other quadrants, but this has not manifested into a confluent lesion and

therefore is not scored. (C–E) Example of LFB image, and the greyscale and thresholded image in imageJ. Please click here

to view a larger version of this figure.
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Figure 3: Spinal cord sections stained with CD45, LFB H&E, LFB and SMI-32. Examples of an early (A,C,E,G) and late

(B,D,F,H) sub-meningeal lesion in the spinal cord stained for CD45 antibody (A,B), LFB/H&E (C,D), LFB alone (E,F), and

SMI-32 antibody (G,H). Black arrows show examples of cells stained with each respective antibody. White arrows show

putative microglia that have been stained as CD45+ . Scale bar = 50 µm. This figure shows representative staining of lesions

in the spinal cord of a female C57BL6/J mouse during EAE and highlights how pathology can be different across different

spinal cord sections. Please click here to view a larger version of this figure.
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Figure 4: Application of scoring for lesions and percent demyelination in EAE. Shown is an example of an EAE

experiment where female mice deficient in Ovarian cancer G-protein coupled receptor 1 (OGR1) gene on the C57BL6/

J background developed less severe clinical EAE than wildtype (WT) female C57BL6/J mice. EAE was induced by

immunization with MOG p35-55/CFA plus PTX and mice were scored according to the following clinical scale: 1 = tail

paralysis. 2 = hindlimb and foot weakness, 3 = hindlimb paralysis, 4 = forelimb weakness, 5 = moribund. (A) Mean + SEM

clinical scores of mice over time. (B) Shown is an example of LFB/H&E staining in the ventral spinal cord. Scale bar = 50

µm. (C)  Mean + SEM percent quadrants that contained demyelinating lesions. (D) Mean + SEM percent demyelination in

each group. (E) shows result from another experiment in MOG p35-55-induced EAE in C57BL6/J mice where EAE scores

of individual mice were summed over the 30 days of observation and were correlated with the percent demyelination in the

spinal cord. Correlations were performed using a Spearman test. Panels in (A–D) are adapted from Souza C et al.29 . Data in

(E) are original data. *P<0.05, **P<0.01, ***P<0.001. Please click here to view a larger version of this figure.
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Figure 5: Application of SMI-32 staining to understand the effect of a genotype on clinical EAE phenotype. This

figure shows an example of an EAE experiment where male and female wildtype (carry floxed allele of Ppard) and myeloid

specific Ppard mutant mice (LysMCre : Ppardfl/fl) on the C57BL6/J background were immunized with MOG p35-55/CFA and

PTX and were followed for 45 days. (A) shows the mean + SEM clinical scores of mice. (B) shows mean + SEM results

of histological scoring of the number of SMI-32+  axons in the spinal cord, %quadrants with submeningeal lesions, percent

quadrants with perivascular cuffs, and #CD3 lesions in the cerebellum per mm2  tissue. This experiment showed a genotype

effect on SMI-32 staining. This figure is adapted from Drohomyrecky. et al.15 . Please click here to view a larger version of

this figure.
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Figure 6: Examples of CD45+ /hematoxylin staining in brain coronal sections in MOG p35-55-induced EAE in female

C57BL6/J mice. CD45+  lesions are shown in brown. (A) CD45+ lesions in the brain stem of coronal sections. Scale bar =

150 μm. (B–G) Examples of CD45+  lesions in the optic nerves (B), meningeal extensions under the hippocampus (C), the

brain stem (D), the corpus collosum (E), the medial habenula near the ventricle (F), and the cerebellum (G).  Scale bar: (B–

G) = 50 µm. Please click here to view a larger version of this figure.
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Figure 7: sNF-L levels in serum in MOG p35-55-induced EAE. (A) Serum NFL levels collected from female control and

EAE mice at end-point of one experiment. Data was analysed using a two-tailed Mann Whitney test. (****p value < 0.0001).

(B) Spinal cord sections were harvested at end-point and stained with SMI-32. The number of positive cells per white matter

tissue area was determined and correlated with serum NF-L at endpoint using a Spearman test. Please click here to view a

larger version of this figure.

Supplementary Table 1: Description of baths used in

tissue processing. Cassettes are automatically moved

through these series of baths using an automated processor.

Please click here to download this File.

Supplementary Table 2: Steps in Luxol Fast Blue and

Hematoxylin and Eosin staining. This table outlines the

order of steps in the Luxol Fast Blue and Hematoxylin and

Eosin staining protocol. Please click here to download this

File.

Supplementary Table 3: Antibodies used for

immunohistochemical staining. Described are the

antibodies that are used in this protocol as well as those that

can be used to further explore inflammation, microgliosis, and

astrogliosis. Please click here to download this File.

Supplementary Table 4: How to convert .czi to TIFF

files. Note that it is optimal to use a high-resolution image,

but medium-resolution images can be saved instead if the

working memory of the computer is limiting. It is imperative

to use images of the same resolution across analyses. Also,

note that the last image of the series is the slide label. Avoid

reading the label to ensure that the analysis is blinded.30 ,31

Please click here to download this File.

Discussion

Histological staining of the spinal cord is an important tool

in assessing EAE disease severity, particularly in instances

where there are differences between treatment groups in the

extent of disease recovery in the post-acute phase of disease.

Staining for immune cell infiltration (CD45), myelin (LFB)

and axonal injury (SMI-32) helps characterize the underlying

cause of the altered clinical scores in mice. The histological
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staining protocol described here provides a perspective of

inflammation as well as the extent of myelin and axonal injury.

Furthermore, the results shown validate sNF-L measurement

as a method to assess the extent of overall neuronal damage

in EAE.

The critical parameters for this analysis are to ensure that

investigators are blinded to the identity of the sections and

that there is equivalent sampling at each level of the spinal

cord across the different mice. This is because the severity

of inflammation can be greater at lower levels of the cord.

Another critical parameter is the size of the experimental

groups. Spinal cords and brains are typically harvested from

6–8 mice per group at endpoint to see significant differences

between groups with treatments or genotypes having modest

effect sizes. It is also important to ensure that selected

mice, when averaged, have representative mean scores of

the entire group. Regarding trouble shooting, a common

problem encountered by those who are inexperienced with

the protocol is that the spinal cord is fixed for an insufficient

length of time and it is not easily extruded from the spinal

column. If this is the case, the spinal cord can be manually

dissected from the column by clipping along the spinous

processes using fine scissors and opening the column to

reveal the spinal cord. Alternatively, tissues can be fixed for

a few additional days without interfering with the success

of antibody staining. The antibody clones that are described

here work in tissue fixed up to 2 weeks in formalin.

Embedding the spinal cord pieces requires skill and practice.

It is recommended that eye loupes be worn and a lamp

be directed over the embedding station to better visualize

whether the sections are falling in cross-section or in

longitudinal section. Keeping the lengths of the spinal cord

pieces at less than 2 mm during grossing will help them fall

in cross-section. Another common problem encountered for

less-experienced users is that the LFB evaporates during

the overnight incubation, leaving half of the slide stained

and half unstained. To avoid evaporation, the glass staining

dish should be sealed with thermoplastic film and then

plastic wrap. If evaporation occurs and sections are unevenly

stained, it is recommended to completely de-blue the slides

with lithium carbonate and re-stain them again in LFB

overnight. Another common issue is that users do not fully

de-blue the grey matter after LFB. It is critical to examine

individual sections under the microscope to ensure that a

sufficient amount of de-bluing has been reached before

proceeding with other steps in the protocol. In addition, though

the CD45 and SMI-32 IHC stains perform robustly, it is

still important to trouble shoot antibody concentrations in

preliminary experiments for each new antibody lot received.

This can be done by testing a variety of concentrations of

the antibody on a positive control section (EAE spinal cord).

First-time staining should also include a negative control

that consists of secondary antibody alone without primary

antibody added. Finally, it is critical in the image analysis to

threshold individual images as staining can be uneven across

slides or sections.

This protocol uses freely available software. If one does not

have access to a processor, an embedder, or microtome,

these steps can be sourced to a hospital-based pathology

core that offers these services. Also, if one does not have

access to a slide scanner, one can use a light microscope

that is fitted with a video camera to save TIFF images of

the spinal cord or brain regions. For a microscope-based

workflow, capture LFB or LFB/H&E sections at low power (40x

magnification) and for CD45 and SMI-32 staining, image at

least four windows that are centered in the ventral, dorsal, and

lateral parts of the spinal cord (200x magnification for CD45
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and 400x magnification for SMI-32). Image analysis can be

performed on these images to quantify staining in a similar

manner as described.

The decision of what histological approach to take to

score EAE is dependent on how much the clinical scores

differ between groups. For example, if there are drastic

differences in EAE clinical score (one group got EAE and

one did not), this usually relates to differences in peripheral-

mediated inflammation. In this case, scoring for the presence

of demyelinating lesions on LFB/H&E-stained sections is

sufficient and will reveal differences between groups. If

groups are more similar in clinical score at onset and there

are instead differences in the extent of clinical recovery

(e.g. experiment in Figure 5A), it is best to apply the full

histological workflow that is outlined here, including scoring

of brain inflammation in the brain stem and cerebellum, to

distinguish whether the differences the disease chronicity

relate to differences in inflammation or tissue damage.  If

differences in inflammation are found as assessed by CD45

counting, further IHC studies can be done to stain for T cells

(anti-CD3), infiltrating monocyte/macrophages (Mac3) and

microglia (Iba-1/TMEM119) (recommended antibody clones

are in Supplementary Table 3). Microglia activation is

reflected by an increase in the intensity of Iba-1 staining on

double-labeled Iba-1+TMEM-19+ microglia and an increased

retraction of microglia processes that can be assessed by

Sholl analysis on sections32 . Furthermore, techniques like

flow cytometry or single cell RNA sequencing can be applied

to conduct a deeper characterization of the frequency and

phenotype of immune populations in the brain and spinal cord.

The counting of SMI-32+  axons is a sensitive method to

detect axon injury in EAE32,33  and in MS34 . SMI-32, which

detects the non-phosphorylated form of neurofilament heavy

or medium accumulates in end-bulbs of transected neurons.

An alternative to detect injured axons is to stain with amyloid

precursor protein (APP) that can accumulate in axons as a

result of disrupted axon transport33 . The pattern of staining

for SMI-32 and APP though both both reflective of axon

injury, do not typically overlap, indicating they they are

detecting different pathologies33 . One can also complement

histological measures of axon injury by measuring sNF-L,

which is a rapid and sensitive measure of ongoing axonal

injury in both the spinal cord and the brain. It offers the

advantage that it can be done in half a day in living mice. A

drawback of this method is that the kits are expensive and

the machine is highly specialized. The company that sells the

sNF-L kit does offer a fee for service for those who do not

have access to a SIMOA machine. An alternative to assessing

axon injury is to score for axon loss by either counting axons

in toluidine blue-stained sections of the spinal cord12  or

counting neurofilament bundles detected by SMI-31 in areas

of the spinal cord white matter32 . Both of these are more

laborious approaches than SMI-32 or sNF-L measurement.

If EAE clinical scores differ between groups, but scoring for

inflammation, demyelination and axonal injury does not reveal

differences between groups, it may be useful to stain for

astrocyte activation using GFAP (see Supplementary Table

3 for recommended antibody clone). Astrocyte activation is

associated with an increase in GFAP staining and this has

been shown to correlate with EAE progression in some EAE

models including chronic EAE in the DA rat35 .

In conclusion, this protocol describes methods and provides

an analysis workflow to conduct histological scoring of EAE.

Disclosures

Shannon Dunn consults for FSD Lucid Psycheceuticals.     

https://www.jove.com
https://www.jove.com/


Copyright © 2024  JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

jove.com February 2024 • 204 •  e65738 • Page 23 of 25

Acknowledgments

We thank Dr. Raymond Sobel (Stanford University) for

showing us his method of grossing and fix brain and spinal

cord sections. We thank Kyle Roberton and Milan Ganguly

from the Toronto Centre for Phenogenomics for learning the

embedding method and for cutting so many of our brain and

spinal cord sections. We thank Dr. Matthew Cussick and Dr.

Robert Fujinami (University of Utah) for sharing their protocols

for scoring submeningeal and perivascular inflammation in

the spinal cord. We thank Shalina Ousman for sharing the

clone of the CD45 antibody. We thank Xiofang Lu for training

on the tissue processor and tissue embedding station and

maintaining this equipment at the Keenan Research Centre of

Biomedical Research at St. Michael’s Hospital. This work was

supported by a Biomedical grant from MS Canada (to SED).

Carmen Ucciferri is supported by a studentship from the

Government of Canada. Nuria Alvarez-Sanchez is supported

by a Keenan post-doctoral fellowship.   

References

1. Constantinescu, C. S., Farooqi, N., O'Brien, K. Gran, B.

Experimental autoimmune encephalomyelitis (EAE) as a

model for multiple sclerosis (MS). Br J Pharmacol. 164

(4), 1079-1106 (2011).

2. Rasouli, J. et al. Expression of GM-CSF in T cells is

increased in multiple sclerosis and suppressed by IFN-

beta therapy. J Immunol. 194 (11), 5085-5093 (2015).

3. Zrzavy, T. et al. Loss of 'homeostatic' microglia and

patterns of their activation in active multiple sclerosis.

Brain. 140 (7), 1900-1913 (2017).

4. Kutzelnigg, A. Lassmann, H. Pathology of multiple

sclerosis and related inflammatory demyelinating

diseases. Handb Clin Neurol. 122, 15-58 (2014).

5. Glatigny, S. Bettelli, E. Experimental autoimmune

encephalomyelitis (EAE) as animal models of multiple

sclerosis (MS). Cold Spring Harb Perspect Med. 8 (11),

(2018).

6. Kipp, M., Nyamoya, S., Hochstrasser, T. Amor, S.

Multiple sclerosis animal models: A clinical and

histopathological perspective. Brain Pathol. 27 (2),

123-137 (2017).

7. Nikic, I. et al. A reversible form of axon damage

in experimental autoimmune encephalomyelitis and

multiple sclerosis. Nat Med. 17 (4), 495-499 (2011).

8. Croxford, A. L. et al. The cytokine GM-CSF drives

the inflammatory signature of CCR2+ monocytes and

licenses autoimmunity. Immunity. 43 (3), 502-514 (2015).

9. Jones, M. V. et al. Behavioral and pathological

outcomes in MOG 35-55 experimental autoimmune

encephalomyelitis. J Neuroimmunol. 199 (1-2), 83-93

(2008).

10. Zuo, M. et al. Age-dependent gray matter

demyelination is associated with leptomeningeal

neutrophil accumulation. JCI Insight. 7(12), e158144

(2022).

11. Bannerman, P. G. et al. Motor neuron pathology in

experimental autoimmune encephalomyelitis: Studies in

thy1-yfp transgenic mice. Brain. 128 (Pt 8), 1877-1886

(2005).

12. Cahill, L. S. et al. Aged hind-limb clasping experimental

autoimmune encephalomyelitis models aspects of the

https://www.jove.com
https://www.jove.com/


Copyright © 2024  JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

jove.com February 2024 • 204 •  e65738 • Page 24 of 25

neurodegenerative process seen in multiple sclerosis.

Proc Natl Acad Sci U S A. 116 (45), 22710-22720 (2019).

13. Stromnes, I. M. Goverman, J. M. Active induction of

experimental allergic encephalomyelitis. Nat Protoc. 1

(4), 1810-1819 (2006).

14. Stromnes, I. M. Goverman, J. M. Passive induction of

experimental allergic encephalomyelitis. Nat Protoc. 1

(4), 1952-1960 (2006).

15. Drohomyrecky, P. C. et al. Peroxisome proliferator-

activated receptor-delta acts within peripheral myeloid

cells to limit the expansion of myelin-reactive T helper

cells during experimental autoimmune encephalomyelitis

(EAE). J. Immunol. 10, 2588--2601  (2019).

16. Osorio-Querejeta, I. et al. The innovative animal

monitoring device for experimental autoimmune

encephalomyelitis ("I am D EAE"): A more detailed

evaluation for improved results. Mult Scler Relat Disord.

63, 103836 (2022).

17. Wang, C. et al. Induction and diverse

assessment indicators of experimental autoimmune

encephalomyelitis. J Vis Exp. 187,  e63866 (2022).

18. Shahi, S. K., Freedman, S. N., Dahl, R. A., Karandikar,

N. J. Mangalam, A. K. Scoring disease in an animal

model of multiple sclerosis using a novel infrared-based

automated activity-monitoring system. Sci Rep. 9 (1),

19194 (2019).

19. Kluver, H. Barrera, E. A method for the combined staining

of cells and fibers in the nervous system. J Neuropathol

Exp Neurol. 12 (4), 400-403 (1953).

20. Disanto, G. et al. Serum neurofilament light: A biomarker

of neuronal damage in multiple sclerosis. Ann Neurol. 81

(6), 857-870 (2017).

21. Novakova, L. et al. Monitoring disease activity in multiple

sclerosis using serum neurofilament light protein.

Neurology. 89 (22), 2230-2237 (2017).

22. Pouzol, L. et al. Act-1004-1239, a first-in-class

CXCR7 antagonist with both immunomodulatory and

promyelinating effects for the treatment of inflammatory

demyelinating diseases. FASEB J. 35 (3), e21431

(2021).

23. Breakell, T. et al. Obinutuzumab-induced B-cell depletion

reduces spinal cord pathology in a CD20 double

transgenic mouse model of multiple sclerosis. Int J Mol

Sci. 21 (18), 6864 (2020).

24. Aharoni, R. et al. Neuroprotective effect of glatiramer

acetate on neurofilament light chain leakage and

glutamate excess in an animal model of multiple

sclerosis. Int J Mol Sci. 22 (24), 13419 (2021).

25. Sternberger, L. A. Sternberger, N. H.

Monoclonal antibodies distinguish phosphorylated and

nonphosphorylated forms of neurofilaments in situ. Proc

Natl Acad Sci U S A. 80 (19), 6126-6130 (1983).

26. Mouse spinal brain map. Https://Mousespinal.Brain-

Map.Org/Imageseries/Showref.Html. (2023).

27. Kuhle, J. et al. Serum neurofilament is associated with

progression of brain atrophy and disability in early MS.

Neurology. 88 (9), 826-831 (2017).

28. Benkert, P. et al. Serum neurofilament light chain for

individual prognostication of disease activity in people

with multiple sclerosis: A retrospective modelling and

validation study. Lancet Neurol. 21 (3), 246-257 (2022).

29. D'Souza, C. A. et al. OGR1/GPR68 modulates the

severity of experimental autoimmune encephalomyelitis

https://www.jove.com
https://www.jove.com/


Copyright © 2024  JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

jove.com February 2024 • 204 •  e65738 • Page 25 of 25

and regulates nitric oxide production by macrophages.

PLoS One. 11 (2), e0148439 (2016).

30. Imagej. Https://Www.Imagej.Nih.Gov/Ij/Download.Html.

(2023).

31. Openmicroscopy. Https://Www.Openmicroscopy.Org/

Bio-Formats/Downloads. (2023).

32. Doroshenko, E. R. et al. Peroxisome proliferator-

activated receptor-delta deficiency in microglia results in

exacerbated axonal injury and tissue loss in experimental

autoimmune encephalomyelitis. Front Immunol. 12,

570425 (2021).

33. Soulika, A. M. et al. Initiation and progression

of axonopathy in experimental autoimmune

encephalomyelitis. J Neurosci. 29 (47), 14965-14979

(2009).

34. Trapp, B. D. et al. Axonal transection in the lesions of

multiple sclerosis. N Engl J Med. 338 (5), 278-285 (1998).

35. Lassmann, H. Bradl, M. Multiple sclerosis: Experimental

models and reality. Acta Neuropathol. 133 (2), 223-244

(2017).

https://www.jove.com
https://www.jove.com/

